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1. IRT simulation 

1.1 Introduction 
Unlike classical test theory, IRT does not in general base the estimate of the respondent's 
ability (or other attribute) on the number-correct (NC) or summed score. To distinguish IRT 
scores from their classical counterparts, we refer to them as "scale" scores. There are two 
instances under which the IRT scale scores may be one-to-one related (in a nonlinear 
fashion). 
  
IRT models often rely on, or are based on three assumptions: (1) the mathematical form of 
the item characteristic functions, (2) the dimensionality of the item space and (3) the 
distribution of the abilities. Violations of these assumptions can produce serious negative 
consequences to the measurement process. One way of evaluating the impact of violating 
these assumptions, as well as studying factors such as the impact of choice of models, 
examinee sample sizes, the shape of ability distributions, and test length, and many other 
factors, is via simulation studies, also referred to as Monte Carlo studies. 
 
Monte Carlo studies have become an important tool in the development of theory and 
methods. For example, if the properties of an estimator or fit statistic are very difficult to 
work out analytically, a Monte Carlo study may be conducted to estimate those properties. 
Monte Carlo studies often provide a significant amount of the available knowledge of the 
properties of statistical techniques, especially under various alternative models. A large 
proportion of the articles in the statistical literature include Monte Carlo studies. For 
example, in recent issues of the Journal of the American Statistical Association almost half 



of the articles report on Monte Carlo studies that supported the research. 
 
Simulation brings to the surface inconsistencies and inefficiencies, for example in situations 
where the sample size is small; the number of dimensions is large; and/or a mixture of 
different model types (for example the 2-parameter logistic, graded and nominal) are fitted to 
the items. A further example is deviations from model assumptions. When the same 
simulation procedure with a specified starting random seed is repeated several times, the 
generated data can be used to assess accuracy of the parameter estimates and the robustness 
of standard errors and fit statistics. In practice, it is often difficult and costly to repeat the 
exact circumstances under which data was collected. In contrast, with simulation software 
one can test the same system repeatedly in a time-efficient manner with different inputs and 
under different scenarios.  
 
The purpose of the IRTPRO simulation module is to simulate examinee item response data 
given true model parameter values (both items and subjects). The simulation module creates 
data files in a form that can be directly run in the IRTPRO software as well as being saved for 
future use. 

    
IRTPRO has the capability of generating data from all implemented IRT models, including 
multidimensional, bifactor, and multilevel models. The command syntax for generating data 
has the same basic structure as the model-fitting syntax.  

1.2 Simulation using a social life feelings (SLF) dataset 
The dataset used in this section is taken from an extensive study of social life feelings 
reported in Schuessler (1982) and Krebs and Schuessler (1987). The aim was to establish 
scales for use in social research. According to Bartholomew (1998), the aim of the study was 
to establish scales for use in social research that were comparable in quality with those used 
in ability testing. For illustration purposes, the data used in this section is from the German 
sample consisting of the following five items: 

  
o Anyone can raise his standard of living if he is willing to work at it (SLS1). 
o Our country has too many poor people who can do little to raise their standard of living 

(SLS2). 
o Individuals are poor because of the lack of effort on their part (SLS3). 
o Poor people could improve their lot if they tried (SLS4). 
o Most people have a good deal of freedom in deciding how to live (SLS5). 

 
Responses are based on a sample size of 1490 individuals. The spreadsheet below displays 
item values for cases 680 to 690. The name of the dataset is SLF.ssig and is stored in the 
folder IRTPRO Examples\By Dataset\Social Life Feelings\ 



 

 
 

1.2.1 Calibration and Simulation 

In this section, 3PL models are fitted to the five items, labeled SLS1 to SLS5 respectively, and 
the estimated parameters are saved to a text file with extension -prm.txt. Five IRTPRO 
datasets (.ssig), with a sample size of 1490 each, are simulated.  
 
From the main menu bar, select the Analysis, Unidimensional IRT… option to obtain the 
Unidimensional Analysis window shown below. Use the Description tab to enter a title and 
comments. 
 

 
 



 
 

Since the dataset SLF.ssig is based on a single group (Germany, 1490 individuals), the Group 
tab is skipped and we proceed to the Items tab to select all five items.  
 

 



 
The Models dialog displays the model-type to be fitted to each item. Since all items are 
binary, the default model is 2PL. To change the model type to 3PL, select all the cells below 
the Model heading, and right-click to display the valid model types for this selection (2PL and 
3PL). Click on 3PL to change from the default model type to 3PL. 
 

 
 
The following message is displayed. Click the Yes button to continue. 
 

 
   

To ensure that the estimated parameters are save to a –prm.txt file, click the Options… button 
(bottom right-hand corner of the previous display). This action invokes the Options window. 



Click the Save tab and make sure that Item parameters estimates (–prm.txt) is selected. 
 

 
 

Click OK to return to the Unidimensional Analysis window and click on the Simulation tab to 
display the Simulation dialog. 

 
Using this dialog, make the following selections: 
o Simulation (click check box) 
o Number of Examinees = 1459 (the default) 
o Number of Replicate Datasets = 5 (default = 1) 
o Check the Save as –simul.ssig files (default is simul.txt) 
o Select Random number generator seeds (defaults = 4987 and 7681)  

  
Note that for a given set of seeds, the contents of the datasets will be identical if the above 
procedure is followed on different computers. 
  
When done, click the Run button to start calibration and simulation. 
 



 
 

If the analysis completes successfully, two output files are created with extensions: 
o –irt.htm (calibration), and 
o –sim.htm (simulation). 
 
The Window menu (below) shows  the selection of the IRT analysis (simulation) output. 



 
 

Portions of the –irt.htm output are shown next. The first table gives the parameter estimates 
and standard error estimates for the five items. 
 

3PL Model Item Parameter Estimates for Group 1, logit: aθ + c or a(θ – b) (Back to TOC)  
 

 
 



Likelihood based statistics and fit statistics are given in the output shown below. Both the 
AIC and BIC statistics are used as a model selection tool.  

 
Likelihood-based Values and Goodness of Fit Statistics (Back to TOC)  
 

 
 
The simulated datasets are named SLF.Test1-simul1.ssig, SLF.Test1-simul2.ssig, …, 
SLF.Test5-simul1.ssig. Below the first 10 cases of the data set SLF.Test1-simul1.ssig are 
displayed.   
 

 
 
The first column contains the dataset replicate number (Replicate), the second column the 
group number (Group), the third column the examinee number (CaseNum), followed by the 
items in the order that they were selected. 

1.2.2 Simulation based on a parameter file and an .ssig file  

In this section, use is made of the IRTPRO dataset SLS.ssig, and the parameter estimates, 
obtained as described in the previous section, are read from a –prm.txt parameter file. 
Simulation is accomplished by selecting the Analysis, IRT Simulation… option from the main 
menu bar. 

 
Start by opening the IRTPRO data file SLS.ssig located in the folder IRTPRO Examples\By 



Dataset\Social Life Feelings\. If this file is still open from a previous session, close it first and 
then re-open it, otherwise the IRT Simulation… option might be disabled.  

 

 
 

By selecting IRT Simulation…, a Use Saved Command File message box is displayed. Since 
we do not want to overwrite the existing command file, the No button is clicked. 

 

 
 

Use the Rename option (obtained by right-clicking next to an existing Test1 tab to rename a 
test)  and rename the Test1 tab to 3PL_SIM, then enter a title and comments as shown below. 

 



 
 

Proceed to the Items tab and select the items SLF1 to SLF5. 
 

 
 

Select the Models tab, then change the models to 3PL as discussed in the previous section.  



 

 
 

1.3 Simulation when only a parameter file is available 
In practice, many datasets are regarded as confidential and can not be made available to 
researchers not affiliated with the organization that owes the data. However, estimation 
results are often available in the form of a publication or these results can be shared in the 
form of an IRTPRO parameter file. 
 
For illustrative purposes, assume the dataset PISAMathBook1USUK.ssig located in the folder 
IRTPRO Examples\By Data Set\PISA MathBook1\  is not available to the public. Below we 
show the first 15 cases for items Walking3 to Grow2 and the grouping variable Country.  
Missing values in the data are coded as 9.  
 



 
 

An analysis, testlet response theory (TRT), based on this dataset is given elsewhere. For the 
TRT analysis, a multidimensional model for more than one group is fitted. To obtain a 
parameter  
 

 
 

file, open the file PISAMathBook1USUKEX.irtpro, select the TRT test tab, and then click on 
the Options, Save tab as shown above. When running the TRT analysis a parameter file, 
labeled PISAMathBook1USUKEX.TRT-prm.txt is produced. 
 
To simulate data using this parameter file, we start by generating a “fake” dataset that will 
contain the parameter names, category values and allow us to specify the sample size for 
each group. This is accomplished by selecting the File, Create SSIG for Simulation option as 
shown below.   

 



 
 

By selecting this option, the screen shown below is activated. Browse for the parameter file. 
The .ssig file will have the same name, but with extension –gen.ssig. As the default, the file 
PISAMathBook1USUKEX.TRT-gen.ssig is automatically generated  
 
 

 
 

Suppose we are interested in simulating 1,000 cases for each group. These values are then 
entered in the Number of cases text box as shown above.  Click the OK button to generate 
and display the .ssig file. The first ten records are shown below: 

 



 
 

The next step is to select the Analysis, IRT Simulation option from the main menu bar: 
 

 
 

Select the Description tab and enter a title and comments as shown below. 
 



 
 

From the Group tab, select the variable Group then click on the Items tab and select all the items 
listed. Make sure that the Apply to all groups button is clicked before proceeding to the Models 
tab. Use the Apply to all groups button to ensure that the same models are selected for both 
groups. 
 
The Group, Items and Models screens are shown below: 



 
 
 

 
 



  
 

Next, click the Read parameter values… button (lower right-hand corner just below the Item 
List column, see image above) to activate the Open dialog.  
 

 
 



Click the Open button to return to the Simulation window. Select the Simulation tab and 
make the following selections: 
o Number of Examinees per group = 1000 (the default) 
o Number of Replicate Datasets = 2 (default = 1) 
o Check the save as –simul.ssig files (default is =simul.txt) 
o Percentage missing values = 5% 
o Select Random number generator seeds (defaults = 4987 and 7681)  

  

 
 

The simulation procedure is started by clicking the Run button. 
 

Selections of the output are shown below: 
 



 

 
 

 

 
 
 



 
To view the files generated by the simulation procedure, use the File, Open option and select 
files of type (*.ssig) as shown in the Open dialog below. 
 

 
 
The first 15 records of the second replicate file is shown below. Note that -1 denotes a 
missing value. 
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